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INTRODUCTION

Hello, and welcome to Flash 8 Essentials, the result of a collaboration between friends of ED
and some of the most talented Flash developers in the world today. It’s been a long, hard
road getting here, but we’ve done it, and we’re very proud of our creation. We designed this
book to serve a number of purposes. It’s an essential guide to all of the great new features
available in Flash 8, it’s a reference guide for you to look up all those fiddly details, and it’s
also a gallery of inspirational examples to help you go further in your work, allowing you to
create more beautiful, breathtaking designs and more usable applications.

As you’ve no doubt realized if you've started to experiment with Flash 8, Flash has come a
very long way since the days of Flash 3 and 4. Some of you will remember even earlier than
that. (Remember what Flash was like before ActionScript? OK, let’s not go there .. )

This book is broken down into ten chapters and an appendix. Each chapter deals with a
different new area of Flash 8, getting you up to speed as quickly as possible with the new
features, using a combination of easy-to-follow tutorials, reference material, and inspira-
tional examples. The appendix is a gallery of fully-functional examples—some of the stuff is
touched upon in previous chapters, and some isn’t. The chapters are as follows:

B In Chapter 1, Matt Voerman introduces you to the world of Flash 8, summarizing the
new features and setting the scene nicely for the rest of the book.

B Chapter 2 sees Craig Swann and Glen Rhodes playing with blend modes—blending
movie clips together for some exciting graphical effects, the likes of which were pre-
viously only available in graphics packages like Photoshop.

H Chapter 3 sees Craig and Glen again take the helm, looking at the all-new filter
effects, another set of functionality that has been borrowed from graphics packages.
Filters allow you to apply effects such as drop shadows to text or movie clips easily—
what previously required a lot of hard work can now be achieved with a few clicks on
the Flash interface. And there’s much more to discover than that, of course.

B Todd Yard looks at Flash 8 drawing improvements in Chapter 4, covering Object
Drawing mode, gradient enhancements, and much more.

® In Chapter 5, Craig and Glen are back to give you the lowdown on the exciting
advances made with video in Flash 8, all thanks to the new On2 VP6 codec. Coverage
includes some exciting ActionScript video manipulation, and a great game that makes
use of the new video alpha channel!
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B Matt returns to the scene in Chapter 6 to explore Flash 8's TextField improve-
ments, including smoother text using Saffron and text anti-aliasing using both the IDE
and ActionScript classes.

H |In Chapter 7, friends of ED’s very own Chris Mills demonstrates the new Flash 8
performance-enhancing features, including bitmap caching and the Show Redraw
Regions option.

H Chapter 8 is the domain of Paul Barnes-Hoggett, who dives deep into the exciting
new BitmapData API. He shows you how all the important methods work before
following up with some exciting applied examples.

B Chapter 9 sees Todd return to present some of his amazing work with the new
Flash 8 features—getting creative with filters, masks, and animation. Some of the
effects presented here are easier to achieve using Flash 8 than previous versions;
some were nearly impossible in previous versions!

B In Chapter 10, as you get close to the crescendo of the book, Craig and Glen give you
an introduction to the ExternalInterface API, which allows your SWFs to easily
and effectively communicate with host applications written in Java, C#, etc., for some
interesting advanced application development techniques.

B last but certainly not least, Stephen Downs (aka Tink) presents a gallery of inspira-
tional examples in the Appendix, which includes a few features not covered in the
rest of the book, such as the FileReference object. He also revisits a plethora of
examples introduced earlier, with breathtaking results.

Who this book is for

Simple—this book is for anyone with previous experience in Flash who wants to get up to
speed with the new features introduced in Flash 8 as soon as possible. We won’t waste time
looking at timeline basics and tweens, as we think it will be insulting to your intelligence. We
know how anxious you must be to further your knowledge with a minimum of time invest-
ment and get back to your work, fully harnessing the power of Flash 8. These are busy times
for Flash-using professionals.

Do | need to have Flash 8?

In a word, yes. This book won’t be much use to you if you haven’t upgraded to Flash 8. If you
want to buy this book as a guide and check out the new features of Flash 8 before you
decide to make that investment, you can always download a 30-day trial version from
www.macromedia.com/cfusion/tdrc/index.cfm?product=flashpro. We would also recommend
going for Flash 8 Professional rather than Flash 8 Basic. While Basic is still a competent product,
you’ll be missing out on some of the amazing new features that are only available in
Professional—video alpha channel support, the stand-alone video encoder, blend modes, and
filters, to name just a few. Go to www.macromedia.com/software/flash/flashpro/productinfo/
features for more information about the new features and their availability in the different
versions.
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Support for this book

All the necessary files for this book can be downloaded from www.friendsofed.com. If you
run into a problem with any of the instructions, check the errata page for this book at
www.friendsofed.com/books/1590595327, or post a question in the friends of ED forum at
www.friendsofed.com/forums, and we’ll try to help you as quickly as possible. If you post to
the forum, please be as precise as you can about the nature of the problem. We’ve made our
very best efforts to ensure that all of the content presented in this book is error free, but
mistakes do occasionally slip through— it’s just a sad fact of life. We do apologize in advance
for any you find.

Xix



1 FLASH 8 OVERVIEW

by Matt Voerman



FLASH 8 ESSENTIALS

From little things, big things grow. When John Gay and Robert Tatsumi first developed their
computer-illustration tool SmartSketch back in 1993, they never imagined that 12 years and
eight versions later their humble application would be the tool of choice of over 1 million
rich-media developers worldwide.

SmartSketch went on to be known as FutureSplash, until its parent company (FutureWave)
was bought out by Macromedia in 1996. Macromedia then changed FutureSplash’s name
to Flash. Fast-forward to April 2005, and Adobe Systems announces its intention to pur-
chase Macromedia in a deal valued at $3.4 billion. Flash, and its global ubiquity, was one of
the main motivators behind Adobe’s acquisition of Macromedia.

Code-named 8Ball during its development phase, Macromedia Flash 8 has now evolved
into the industry standard for creating (and delivering) web-based rich-media content and
applications.

Flash 8 contains a plethora of new features and functionality, with a large portion of them
targeted squarely toward web designers and animators, as well as video and interactive
media professionals. That’s not to say that rich Internet application developers have been
left out in the cold. With its new lightweight, cross-platform runtime and mobile device
authoring features, the Flash Platform (www.macromedia.com/platform) is still the
ideal choice for the development of rich enterprise and mobile applications.

What’s new in both versions of Flash 8

In 2004, Macromedia took the step of splitting Flash into two distinct versions to cater for
their wide designer and developer audience. Flash 8 continues this tradition by creating a
clearer distinction between the two versions with the release of Flash Basic 8 and Flash
Professional 8.

Flash Basic 8 is ideal for web and new-media designers who have elementary requirements
with regard to importing and manipulating various types of media. Flash Basic 8 designers
still gain access to all of Flash’s foundation functionality (including several new workspace
enhancements), but not some of the newer power features of the latest release.

For designers and developers looking to utilize the majority of the new feature sets of
Flash 8, Flash Professional 8 is the preferred option. Flash Professional 8 offers a substan-
tial number of features not found in its sibling’s version, such as graphics effect filters,
alpha channel video support, and custom text anti-aliasing.

The following pages outline the new features available in both versions of Flash 8.

Bitmap caching

Just as web pages are cached in your web browser to assist with the speedy retrieval of
page data, runtime bitmap caching allows you to specify movie clips or buttons that
can be cached within Flash Player (at runtime) to speed up screen redraw. By declaring
that these symbols be cached as bitmaps, the Flash Player doesn’t have to redraw them
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constantly from vector data. This provides a significant speed and performance enhance-
ment. Chapter 7 outlines the details of Flash 8’s speed improvements.

For example, let’s say you've created an animation that uses a complex physics algorithm
to sequentially draw a series of cubes on the screen. Rather than having to execute the
algorithm on a static cube that has already been rendered to the stage, you can use run-
time bitmap caching to effectively freeze these prerendered cubes. This ability to freeze a
static portion of a symbol that isn’t being updated reduces the number of times Flash
Player has to perform a redraw operation. If a region changes onstage, vector data is used
to update the bitmap cache accordingly.

Bitmap smoothing

In previous versions of Flash, there was often a marked difference in the quality of bitmap
images when viewed in the authoring environment than when viewed in Flash Player. The
new bitmap smoothing feature addresses this issue by allowing designers to apply anti-
aliasing to imported images so that they render comparably in both environments.
Figures 1-1 and 1-2 demonstrate the bitmap smoothing feature.
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Figure 1-1. A bitmap image with smoothing not enabled

=
2
]
‘ﬁ

Bitmap Properties
FinalRELogo.aif E
C:\Rock \imagesirockett \FinalRBLo
o
Wednesday, 21 July 2004 7:50:30 AM
500 x 250 pixels at 8 bits per pixel

Import...
Allow smoothing d
= " -T t
s (s o) [v] 7]
Lossless: original = 125.0 kb, compressed =
5.2kb, 4% of original I .
—

Figure 1-2. A bitmap image with smoothing enabled
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New curve algorithm

The new curve algorithm feature allows designers to modify the amount of smoothing
applied to curves drawn with the Brush and Pencil tools. Using the new Optimize Curves
dialog box (see Figure 1-3), you can increase (or decrease) the number of points used to
calculate a curve. The downside of this new feature is that using more points results in
larger SWF files. You can choose to apply this feature to a shape you’ve drawn by selecting
Modify » Shape » Optimize.

Optimize Curves X

None Maximum Cancel

Options: || Use multiple passes (slower)
[#/] Show totals message

Figure 1-3. The new Optimize Curves feature

Gradient enhancements

The gradient enhancements within Flash 8 allow you to add up to 16 colors to a gradient,
as well as use a bitmap as a gradient fill.

A gradient focal point feature has also been added to Flash 8 to give designers greater
control over the direction and focal point of their gradients. Using the Fill Transform tool,
you simply drag the focal point of the gradient from the outside of the object you’re fill-
ing to manipulate how the gradient is rendered within your object.

Flash 8 also allows you to lock a bitmap or gradient fill to give the impression that the
fill extends over the entire stage. New objects that are painted with the locked gradient fill
appear as masks that reveal the underlying gradient or bitmap. (See Figure 1-4.)
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Figure 1-4. Enhanced gradients, including the new gradient focal point

Object Drawing model

In previous versions of Flash, when you used the Brush, Line, Oval, Pencil, or Rectangle tool
to draw an intersecting line (or shape) across another line (or shape), the overlapping
objects would be divided into segments at the point of intersection. Then, using the
Selection tool, you could select, move, or manipulate each segment individually. This
mode of illustration subtraction is known as the Merge Drawing model (see Figure 1-5).

Flash 8 introduces the Object Drawing model, which allows designers to create shapes and
lines directly on the stage as separate objects. So, unlike the Merge Drawing model, these
new shapes and lines don’t interfere with other pre-existing shapes on the stage (see
Figure 1-6). This allows you to safely overlay objects that are on the same layer without
fear of merging or dissecting parts of other objects on the stage. Activating Object
Drawing is as simple as clicking the Object Drawing button found among the options for
each tool in the Tools panel.

Flash 8’s drawing enhancements are covered
in more detail in Chapter 4 of this book.

Figure 1-5. The traditional Merge Drawing model
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Figure 1-6. The new Object Drawing model, in which shapes maintain their forms when
overlaid

Oval and Rectangle tool settings

To assist designers with common illustration tasks such as specifying the dimensions of fre-
quently drawn objects, Macromedia has introduced a new dialog box, Rectangle Settings
(see Figure 1-7), that allows designers to specify the width and height of ovals and rectan-
gles, as well as the corner radius of rectangles.

Rectangle Settings
Width: | 100 | pixels
Height: | 100 | pixels

Corner radius: | 5 | pixels

Draw from center

Figure 1-7. The new Oval and Rectangle tool settings

Return of Normal Mode scripting

When Macromedia removed Normal Mode scripting from Flash MX 2004, there was an
outcry from the design community. Many designers who weren’t familiar with ActionScript
syntax relied heavily on Normal Mode scripting to add interactivity to their Flash content.

Thankfully, Macromedia believes in listening to its users, and it has returned Normal Mode
scripting to Flash 8, but this time under the moniker of Script Assist.

Essentially, Script Assist is identical to Normal Mode scripting, but with a few enhance-
ments. Script Assist allows you to search and replace text, view script line numbers, and
save a script in the Script pane when you click away from the object or frame (this is
known as pinning). You can also use the Jump menu to go to any script on any object in
the current frame. You can select and deselect Script Assist by clicking the Script Assist
button on the Actions panel (see Figure 1-8).
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Figure 1-8. Normal Mode scripting returns under the moniker of Script Assist.

Improved strokes

Flash 8 has improved the way in which designers can work with paths and strokes. No
longer are you subjected to dealing with only one type of path end (cap); you now have
the option of using either rounded or square caps.

Joins (i.e., the points at which two paths meet) have also received a makeover, with design-
ers now having the choice of using either Bevel, Miter, or Round joins (see Figure 1-9).
These are chosen from the Join drop-down menu, found sitting proudly on the Property
Inspector.

Strokes can now be colored using a gradient, and their maximum size has been increased
from 10 to 200 pixels.
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Rounded Bevel Mitre

Figure 1-9. New stroke joins

TextField improvements

Macromedia has made some significant improvements to the way Flash renders text (both
in the authoring environment and within Flash Player).

New Saffron text-rendering technology has been licensed from Mitsubishi Electric Research
Labs and integrated into Flash Player 8. Saffron greatly improves the quality of the render-
ing of small font sizes.

Historically, text that was rendered within the Flash authoring environment has varied con-
siderably from that rendered within Flash Player. Flash 8’s new WYSIWYG text anti-aliasing
feature ensures that what you see in the authoring environment is what you get in Flash
Player.

In addition to this, Flash 8 now facilitates the anti-aliasing of text based on the specific
end-viewing environment. For example, a line of animated text would have different anti-
aliasing requirements than a large block of static text with a small font size. If you use the
Anti-alias for animation text option, the alignment and kerning information is ignored and
the text is rendered as smoothly as possible.

TextField improvements are covered in much
more detail in Chapter 6 of this book.

Security enhancements

Security of Flash Player and the SWF format has always been paramount for Macromedia.
This view has been further consolidated in Flash 8 with the release of a new Local or
Network Security model. The new model helps prevent SWF files from being used mali-
ciously to access local file information and transmit that information over a network.
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Contained within the Publish Settings dialog box (accessed via File » Publish Settings),
developers now have the option of specifying either a local or a network security model
for their SWF files. Files that have been granted network access permission won’t be able
to access local file data, and vice versa.

SWF file metadata

One of the major bugbears developers have had since Flash’s inception was the product’s
inability to produce to SWFs that could be indexed by search engines such as Google. This
was due to their inability to included embedded metadata within the SWF.

Flash 8 has addressed this issue by adding the capability to import metadata into SWFs in
XML format. This metadata is based on the RDF (Resource Description Framework; see
www.w3 .org/RDF) and XMP (Extensible Metadata Platform; see www.adobe.com/
products/xmp/in-depth.html) specifications, and is stored within Flash in a W3C-
compliant format.

Video improvements

The encoding and workflow of video within Flash 8 has been substantially enhanced via
the introduction of On2’s VP6 video codec. This new codec is part of the core Flash Player
upgrade, and it substantially improves video playback, quality, and encoding. Unlike Flash
Professional, Flash Basic allows only the encoding of embedded video via the Import Video
option. Additionally, encoding to VP6 within Flash Basic is restricted to three presets, none
of which can be modified.

Flash 8 video improvements are covered in
greater detail in Chapter 5 of this book.

Workspace enhancements

This section covers all the workspace enhancements present in Flash 8, added in response
to the reams and reams of valuable feedback given to Macromedia by all you Flash devel-
opers and designers out there. Talk about a community effort!

Exporting keyboard shortcuts as HTML

Flash keyboard shortcuts can now be exported as HTML files that can be viewed and
printed using a standard web browser. This is done by opening the Keyboard Shortcuts
dialog box (Edit » Keyboard Shortcut on the PC, or Flash 8 Professional/Basic » Keyboard
Shortcuts on the Mac) and then selecting the Export As HTML button at the top-right
corner.
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Library enhancements
The following list describes the enhancements to the Flash Library:

® Single library panel: In previous versions of Flash,

separate library panels were required to view the
library items of multiple Flash files. Library panel
enhancements in Flash 8 now allow users to view
the library items of multiple Flash files simultane-
ously in the same single panel (see Figure 1-10).

Library panel state memory: This was allegedly
one of the most requested enhancements for this
version of Flash, but strictly speaking, this is more a
bug-fix than an enhancement. In previous versions
of Flash, when you opened (or closed) library panels
in a document you were working on, and then
closed that document, you would expect the library
panels to be in the same place/order/sequence
when you reopened the document again. Alas, this
was not the case. This “undocumented feature” has
been addressed, and library panels now remember
the state they were left in.

Drag-and-drop library components: When work-
ing with components in previous versions of Flash,
in order to add components to the library of a Flash
file, you first had to place them onto the stage and
then delete them. Flash 8 has addressed this issue,
and you can now place components directly into the
library without first having to place them onto the
stage.

Macintosh Document Tabs

Mac users can now open and easily navigate through multiple Flash documents within the
same window. This is accomplished via the new Macintosh Document Tabs feature, located
at the top of the workspace (see Figure 1-11).
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Figure 1-11.
The new Document Tabs feature
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Object-based Undo and Redo commands

Flash 8 users now have the option of tracking changes from either a document or an
object level. Using the object-based Undo/Redo command lets users undo the changes
made to an object without having to undo changes to other objects (as is the case with the
document-level Undo/Redo option).

Expanded stage pasteboard

The pasteboard is the gray region located around the outside boundary of the stage.
Historically, designers have used this area to place graphics or components they want to
include within a Flash movie, but don’t necessarily want to appear onstage during playback
(or want them to appear at a later point in an animation). Flash 8 has increased the size of
the pasteboard, giving designers more screen real estate to work with.

XML-to-Ul extensibility

Historically, customizing user interfaces (Uls) so they work across the various operating
platforms, such as Windows and Macintosh, has been a developer’s nightmare. To help
ease some of this pain, Netscape and Mozilla teamed up to develop XUL (pronounced
“zool”)—XML User Interface Language.

Using a subset of XUL and some custom Flash tags, XML-to-Ul extensibility allows devel-
opers to extend and automate the Flash 8 IDE to perform common and repetitive
tasks/actions. These include behaviors, commands (JavaScript API), effects, and tools.

The XML-to-Ul engine works with each of these extensibility features to create custom
modal dialog boxes if the extension either requires or accepts parameters. These modal
dialog boxes are required to be dismissed (either accepted or cancelled) by the user
before the application can continue.

New Flash Professional 8-specific features

Flash Professional 8 contains the same feature set as Flash Basic 8, plus an abundance of
new features that are specific only to the Professional edition.

Blend modes

Blend modes allow designers to apply compositing effects to objects located on the stage
(see Figure 1-12). Compositing refers to the process of varying (or blending) the color (or
transparency) of an object on one layer with an object located on a layer below it.

Designers who are familiar with other graphics applications
such as Photoshop will instantly recognize some of the 14 Blend modes are discussed in more
new blend modes available in Flash Professional 8, which detail in Chapter 2 of this book.

include Multiply, Difference, Saturation, and Hue.
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Figure 1-12. The new object blend modes

Custom easing controls

Offering a two-dimensional graph to represent the start and end points of a tweened ani-
mation, Flash Professional 8’s new custom easing controls give designers the ability to pre-
cisely manipulate the speed and complexity of the rate at which their animations ease in
or out. This helps create more realistic movement within animations.

The best way to get to grips with this new feature is to experiment! Try creating a simple
tween animation such as a bouncing ball, and compare the old familiar easing controls
with the new custom easing controls. You can access the new controls by clicking the new
Edit button found next to the familiar controls, which opens up the screen shown in
Figure 1-13. You’ll be impressed.

Graphics effects filters

One of the most heralded new features of Flash Professional 8 allows designers to apply
graphics effects filters—such as the Drop Shadow, Blur, Glow, Bevel, Gradient Bevel, and
Adjust Color filters—to objects located on the stage.

The filter process is performed by passing the object’s image data through a series of algo-
rithms that filter (and subsequently render) the data in a predefined way.

Filters can be applied to MovieClips, TextFields, and button

Filters are covered in more detail | symbols, and are rendered in real time by Flash Player. Filter
in Chapter 3 of this book. effects can be applied either via the Filters tab located in the

Properties panel or programmatically via ActionScript.
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Figure 1-13. The new Custom Ease In/Ease Out controls

More TextField enhancements

Along with the new WYSIWYG Anti-alias for readability and Anti-alias for animation
options contained within Flash Basic 8, Flash Professional 8 has a Custom anti-alias feature
that allows you to customize the sharpness and thickness of your text (see Figure 1-14).

The Sharpness option determines the degree of smoothness between the text edges and

the background, while the Thickness option allows you to tweak the degree of text edge
blend with the background.
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Figure 1-14. The new WYSIWYG text anti-aliasing feature

N
The anti-aliasing options are also covered
in more detail in Chapter 6 of this book.
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More video improvements

One of the major improvements in Flash 8 is the turbo-charging of its video tool set. This
includes the addition of a new video codec within Flash Player for greatly optimized play-
back, and an improved video encoder for stream-

lined workflow. The inclusion of video alpha channel
support raises the bar even further, giving rich-
media designers a new level of creative freedom.

These new video features are covered in
greater detail in Chapter 5 of this book.

Improved video workflow

Flash Professional 8’s Video Import Wizard has been improved to assist designers in
importing (and exporting) video in a variety of formats (such as embedded, progressively
downloaded, streamed, or linked).

The Video Import Wizard also contains an enhanced library of predesigned video player
skins that can be used as playback shells for your imported videos when they’re exported.
These skins are exported as separate SWFs and can be customized to suit your individual
requirements as a designer (see Figure 1-15).

Wizard
Skinning

Description:

The video's skin determines the appearance
and position of the play controls. The
easiest way to get Flash video up and
running is to select one of the provided
skins,

To areate your own look for the play
controls, create a custom skin SWF, select
"Custom” in the Skin drop-down box, and
enter the relative path of the skin SWF in
the URL field.

To remove all play controls and only import
your video, select Tone” from the Skin
drop down box,

Minimum width: 270 Minimum height: 60
S | FSRROHG AR llv|

Back | [ Next ] l Cancel

Figure 1-15. Custom skins for FLV controls
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